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General Instructions

Read the following instructions very carefully and strictly follow them:

1. The JK Board Class 10 Computer Science Exam is of a total of 100 marks, and

the duration of the examination is 3 hours.

2. The paper is divided into two sections — Section A (Compulsory) and Section B

(Elective).

3. Section A is compulsory for all candidates and generally includes objective-type
questions, short answer questions, and long answer questions from the prescribed

syllabus.

4. In Section A, candidates are required to answer all questions. The questions will
cover topics from ancient, medieval, and modern history as prescribed by the

syllabus.

5. Section B consists of elective questions. Candidates are required to attempt

questions from the chosen topic according to the provided options.

6. The questions in Section A will be in the form of multiple-choice, short answer,

and essay-type questions.

7. Use of unfair means or electronic devices during the examination is strictly

prohibited.

1. In HTTP, P stands for

(A) Principle
(B) Protocol



(C) Plan
(D) Player

Correct Answer: (B) Protocol

Solution:

HTTP is the foundational protocol used for data communication on the World Wide Web. It
stands for Hypertext Transfer Protocol. It defines the standard rules that web browsers and
servers use to communicate with each other.

Step 1: Breakdown the acronym.

* H: Hypertext
o T: Transfer
o T: Transfer

* P: Protocol

Step 2: Evaluate the options.

In the context of computer networking, a ”Protocol” is a formal set of rules that govern how
data is packaged and sent. While Principle,” ”Plan,” and "Player” start with the letter P, they
do not describe the technical nature of HTTP.

Step 3: Conclusion.

The P’ in HTTP universally represents "Protocol” in all networking standards. Hence, the

correct answer is (B).

Final Answer:

(B) Protocol

When you see HTTPS, the ’S’ stands for Secure. This means the standard HTTP

protocol is being used over an encrypted connection (SSL/TLS) to protect your data.




2. URL stands for:

(A) Uniform resource link
(B) Universal resource locator
(C) Uniform resource Locater

(D) None of the above.
Correct Answer: (B) Universal resource locator

Solution:

URL stands for Uniform Resource Locator. It is a reference or address used to access
resources on the internet, such as web pages, files, or images.

Step 1: Analyze the options.

(A) Uniform resource link: This is incorrect. URL does not stand for ”link” but ’locator.”
(B) Universal resource locator: This is almost correct, but the standard term is Uniform
Resource Locator,” not ”Universal.” However, many people commonly refer to it as
”Universal,” making this the closest correct option among the choices.

(C) Uniform resource Locater: This has a spelling error ("Locater” instead of ”Locator”) and
is not the standard term.

(D) None of the above: This is incorrect because option (B) is essentially correct.

Step 2: Conclusion.

The correct expansion of URL is “Uniform Resource Locator,” but among the given options,

(B) Universal resource locator is the intended correct answer.

Final Answer:

(B) Universal resource locator

URL stands for Uniform Resource Locator, not Universal. It is a specific string that

constitutes a reference to an internet resource.

3. Example of a web browser:



(A) Google

(B) Facebook

(C) Internet Explorer
(D) Instagram

Correct Answer: (C) Internet Explorer

Solution:

A web browser is a software application used to access and view websites on the internet.
Internet Explorer is a well-known web browser developed by Microsoft.

Step 1: Analyze the options.

(A) Google: Google is a search engine and a technology company, not a web browser.
However, Google Chrome is a web browser.

(B) Facebook: Facebook is a social media platform, not a web browser.

(C) Internet Explorer: This is a web browser developed by Microsoft and was one of the
most widely used browsers for many years.

(D) Instagram: Instagram is a social media platform for sharing photos and videos, not a web
browser.

Step 2: Conclusion.

Among the given options, only Internet Explorer is a web browser. Hence, the correct

answer is (C).

Final Answer:

(C) Internet Explorer

Common web browsers include Google Chrome, Mozilla Firefox, Safari, Microsoft

Edge, and Internet Explorer. Don’t confuse search engines (like Google) with web

browsers.

4. Define Primary Key?



Solution:
A Primary Key is a field (or column) in a database table that uniquely identifies each record
(row) in that table. It must contain unique values and cannot contain NULL values.

Key Characteristics:

* Uniqueness: Each primary key value must be unique across all records in the table.
* Non-null: A primary key cannot have empty or NULL values.
* Unchanging: Primary key values should rarely, if ever, change.

* Single per table: Each table can have only one primary key.

Example:

In a ’Students” table, Student _ID can serve as the primary key because each student has a

unique ID.
Student_ID (Primary Key) | Name | Age | Grade
101 Alice | 15 10
102 Bob 16 11
103 Charlie | 15 10

Final Answer:

A primary key is a unique identifier for each record in a database table.

Primary keys are essential for maintaining data integrity and establishing relationships

between different tables in a relational database.

5. What do you mean by a website?

Solution:

A website is a collection of related web pages that are typically identified by a common
domain name and published on at least one web server. Websites can be accessed through the
internet using a web browser.

Key Components:



* Domain Name: The address of the website (e.g., www.example.com).

* Web Pages: Individual documents written in HTML that contain text, images, videos,

and other content.
* Web Server: A computer that hosts the website and delivers web pages to users.
* Homepage: The main or first page of a website that users typically see when they visit.
Types of Websites:
* Static Websites: Content remains fixed and doesn’t change based on user interaction.

* Dynamic Websites: Content can change based on user interaction, preferences, or

real-time data.
* E-commerce Websites: For buying and selling products online (e.g., Amazon).
* Social Media Websites: For social networking and content sharing (e.g., Facebook).
* Educational Websites: For learning and educational resources (e.g., Khan Academy).

Example:
When you type "www.google.com” in your browser, you are accessing Google’s website,

which consists of multiple web pages for search, images, maps, and more.

Final Answer: A website is a collection of related web pages under a common domain

name, accessible via the internet.

Websites are hosted on web servers and can be accessed using web browsers like

Chrome, Firefox, or Safari.

6. Give an example of a Search engine.

Solution:
A search engine is a software system designed to carry out web searches, allowing users to

search for information on the World Wide Web.
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Examples of Search Engines:

* Google: The most widely used search engine globally, known for its powerful

algorithms and extensive indexing.
* Bing: Microsoft’s search engine, integrated into Windows and Microsoft products.
* Yahoo!: One of the early pioneers in web searching and directory services.
* DuckDuckGo: A privacy-focused search engine that doesn’t track user activity.
* Baidu: The leading search engine in China.
* Yandex: The most popular search engine in Russia.
How Search Engines Work:

1. Crawling: Automated bots (called crawlers or spiders) browse the web to discover new

and updated pages.

2. Indexing: The content found during crawling is analyzed and stored in a massive

database (index).

3. Ranking: When a user enters a query, the search engine uses algorithms to rank the

most relevant results.

4. Displaying: The ranked results are displayed as Search Engine Results Pages (SERPs).

Final Answer:

Google (or any valid search engine like Bing, Yahoo, DuckDuckGo, etc.)

Don’t confuse search engines (like Google) with web browsers (like Chrome). A

browser is used to access websites, while a search engine helps you find information

on the web.




7. Zoom application is used for ______.

Solution:
Zoom is a video conferencing application that enables users to connect through virtual
meetings, webinars, and online collaboration.

Primary Uses of Zoom:

* Video Conferencing: Conduct face-to-face meetings with participants from anywhere

in the world.

e Online Classes: Educational institutions use Zoom for virtual classrooms and distance

learning.

* Webinars: Host large-scale events, presentations, or seminars with hundreds or

thousands of attendees.

 Business Meetings: Corporate teams use Zoom for daily stand-ups, client meetings,

and collaborative sessions.

* Screen Sharing: Share your screen to present documents, slides, or demonstrate

software.

* Virtual Social Gatherings: Friends and families use Zoom for virtual parties,

celebrations, and catch-ups.
Key Features:
* High-quality video and audio
* Chat functionality
* Breakout rooms for smaller group discussions
» Recording capabilities
* Virtual backgrounds

* Waiting rooms for meeting security



Final Answer:

video conferencing / online meetings / virtual communication

Zoom became especially popular during the COVID-19 pandemic as a primary tool for

remote work, online education, and staying connected with loved ones.

8. Give the name of HTML tag used for changing background color of webpage.

Solution:

There is no specific HTML tag solely dedicated to changing the background color of a
webpage. Instead, the background color is controlled using CSS (Cascading Style Sheets).
Methods to change background color:

Method 1: Using the style attribute (Inline CSS)

The background color can be set using the sty 1le attribute within the <body> tag:

<body style="background-color: lightblue;">
<!-- Webpage content goes here -->

</body>

Method 2: Using the <style> tag (Internal CSS)

You can use the <style> tag in the <head> section to define the background color:

<head>
<style>
body {
background-color: lightblue;
}
</style>
</head>



Method 3: Using the bgcolor attribute (Deprecated)
In older versions of HTML, the bgcolor attribute was used with the <body> tag. This

method is now deprecated and should not be used in modern web development:

<body bgcolor="lightblue">
<!-— Webpage content goes here —-—>

</body>

Final Answer:

No specific HTML tag; use CSS with jbodyy, tag or jstyle; tag

In modern web development, always use CSS for styling. The preferred way is to use

internal or external CSS rather than inline styles or deprecated HTML attributes.

9. Define Internet. How is it different from World Wide Web?

Solution:

Definition of Internet:

The Internet is a global network of interconnected computers and devices that communicate
with each other using standard protocols (like TCP/IP). It is a massive hardware and software
infrastructure that connects millions of networks worldwide, enabling data transmission and
communication between billions of devices.

Definition of World Wide Web (WWW):

The World Wide Web (WWW or simply the Web) is an information system on the internet
that allows documents and other web resources to be accessed via URLs (Uniform Resource
Locators). These documents are linked together using hyperlinks and are accessed through

web browsers. The Web is one of the many services that run on the internet.

Differences between Internet and World Wide Web:
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Aspect

Internet

World Wide Web
(WWW)

Definition A global network of | A collection of infor-
interconnected com- | mation and resources
puters and devices. accessible via the in-

ternet.

Nature Hardware and infras- | Software and infor-
tructure. mation system.

Relationship The Internet is the | The Web is a service
medium that carries | that runs on the Inter-
the Web. net.

Analogy Like a railway sys- | Like the passengers

tem (the tracks and

trains).

and goods traveling

on the trains.

Examples of uses

Email, File transfer
(FTP), Online gam-
ing, VoIP (Zoom,

Skype).

Websites, Web pages,
Social media, E-

commerce Ssites.

Protocols used TCP/IP, UDP, etc. HTTP/HTTPS (Hy-
pertext Transfer
Protocol).

Invented/Created Developed in the late | Invented by Tim

1960s (ARPANET).

Berners-Lee in 1989.

Access method

Requires network
connection and ap-

propriate protocols.

Requires a  web
browser and internet

connection.

Key Points to Remember:

* The Internet is the infrastructure (like a highway system).

e The Web is a service that runs on this infrastructure (like the cars and trucks on the

highway).
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¢ Other services that run on the Internet include:

— Email (using protocols like SMTP, POP3, IMAP)
— File Transfer (using FTP)

— Instant Messaging

— Voice over IP (VoIP) services like Zoom, Skype

— Online gaming

Final Answer: Internet is a global network of interconnected computers, while WWW is a

collection of information accessed via the Internet.

Quick Tip

A simple way to remember: Internet is the “network of networks” (the hardware), while
the Web is the ”information space” (the software/service). You can have internet without

the web (e.g., using email or FTP), but you cannot have the web without the internet.

10. What do you mean by relational database? Give its one example.

Solution:

Definition of Relational Database:

A relational database is a type of database that stores and organizes data in tables (also
called relations) consisting of rows and columns. It establishes relationships between
different tables using common fields, allowing for efficient data retrieval and management.
The concept was introduced by E.F. Codd in 1970.

Key Characteristics:

» Tables: Data is stored in tables, where each table represents an entity (e.g., Students,

Employees, Products).
* Rows (Records/Tuples): Each row in a table represents a single, unique record.

* Columns (Fields/Attributes): Each column represents a specific attribute of the entity.
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» Primary Key: A unique identifier for each row in a table.

» Foreign Key: A field that creates a relationship between two tables by referencing the

primary key of another table.

* Relationships: Tables can be related to each other through keys (one-to-one,

one-to-many, many-to-many relationships).

* Structured Query Language (SQL): Used to query and manipulate data in relational

databases.

Advantages of Relational Databases:

 Data integrity and accuracy

* Reduced data redundancy

 Easy data retrieval using SQL

* Flexibility in querying

 Data security

* Support for complex relationships
Example of a Relational Database:

Consider a simple database for a School Management System with two tables: Students

and Courses, and a relationship table Enrollments.

StudentID (Primary Key) Name Age | Grade

101 Alice Johnson | 15 10

Table 1: Students 102 Bob Smith 16 11

103 Charlie Brown | 15 10

104 Diana Prince | 17 12

CourselD (Primary Key) CourseName Credits

CS101 Computer Science 3
Table 2: Courses MATH201 Mathematics 4
ENG102 English Literature 2
SCI103 Science 3
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Table 3: Enrollments (Relationship Table)

EnrollmentID | StudentID (Foreign Key) | CourselD (Foreign Key)
1 101 CS101
2 101 MATH201
3 102 ENG102
4 103 CS101
5 104 SCI103
6 104 MATH201

How it works:
e The Student s table stores information about each student.
* The Courses table stores information about available courses.

* The Enrollments table creates a relationship between students and courses, showing

which student is enrolled in which course.
e StudentID in the Enrollments table is a foreign key referencing the Students table.
* CourselID in the Enrollments table is a foreign key referencing the Courses table.
This structure allows you to answer questions like:
* ”Which courses is Alice Johnson enrolled in?”
* "How many students are taking Computer Science?”

* ”Which students are in Grade 10?”

Common Relational Database Management Systems (RDBMS):
* MySQL
* PostgreSQL
* Oracle Database
* Microsoft SQL Server
* SQLite
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* MariaDB

Final Answer: A relational database organizes data into tables with rows and columns,
establishing relationships between tables. Example: A school database with Students,

Courses, and Enrollments tables.

Quick Tip

Relational databases use keys to establish relationships: Primary Keys uniquely identify
records in a table, while Foreign Keys link to Primary Keys in other tables, creating

referential integrity.

11. Explain in steps how you can create a form in Microsoft Access?

Solution:
A form in Microsoft Access is a database object used to create a user interface for entering,
editing, and displaying data from tables or queries. Forms make data entry easier and more

organized than working directly with tables.

Methods to Create a Form in Microsoft Access:
Method 1: Using the Form Tool (Quickest Method)

1. Open your database in Microsoft Access.

2. In the Navigation Pane, select the table or query that you want to base your form on.
3. Go to the Create tab on the Ribbon.

4. In the Forms group, click on the Form button.

5. Access will automatically generate a simple form with all fields from the selected

table/query.
6. The form will open in Layout View, allowing you to make basic adjustments.

7. Save the form by pressing Ct r1+S or clicking the Save icon, and give it a name.
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Method 2: Using the Form Wizard (More Control)

1. Go to the Create tab on the Ribbon.
2. In the Forms group, click on Form Wizard.
3. In the Form Wizard dialog box:

(a) Select the table or query from the ”Tables/Queries” dropdown.

(b) Choose the fields you want to include in your form by moving them from

”Available Fields” to ”Selected Fields” using the arrow buttons.

(c) Click Next.
4. Choose the layout for your form:

* Columnar (displays fields in a single column)
* Tabular (displays data in a table-like format)
 Datasheet (similar to a spreadsheet view)

* Justified (fields arranged in rows)
Select your preferred layout and click Next.
5. Choose a style for your form from the available options and click Next.
6. Enter a title for your form.

7. Choose whether to open the form to view or enter information, or to modify the form’s

design.

8. Click Finish.

Method 3: Creating a Blank Form (Design View)

1. Go to the Create tab on the Ribbon.
2. In the Forms group, click on Blank Form.

3. A blank form will open in Layout View.
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4. If the Field List pane is not visible, go to the Design tab and click on Add Existing
Fields.

5. From the Field List, drag and drop the desired fields onto the form.
6. Use the Design tab to add various controls like:

 Text boxes

» Labels

* Buttons

» Combo boxes

» Check boxes
7. Arrange and format the controls as needed.

8. Save the form when completed.

Method 4: Using Form Design View (Advanced)

1. Go to the Create tab on the Ribbon.
2. In the Forms group, click on Form Design.
3. A blank form will open in Design View with a grid.
4. Access the Property Sheet (Alt+Enter) to set form properties.
5. Set the form’s Record Source property to the desired table or query.
6. From the Design tab, use the Controls gallery to add various elements to the form.
7. Add fields by dragging them from the Field List or by creating bound controls.
8. Adjust the layout, size, and position of controls.
9. Format the form using the Format tab.

10. Switch to Form View to test the form.

11. Save the form.
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Basic Steps Summary:

Step | Action

1 | Select the table or query for the form

Choose a creation method (Form Tool, Wizard, Blank Form, Design View)

Select fields to include (if using Wizard)

Choose layout and style

Add or arrange controls as needed

Format the form appearance

Save the form with a descriptive name

eI ER NI e Y B N S I S

Test the form in Form View

Form Views in Access:

* Form View: Used to view, enter, and edit data.
* Layout View: Allows you to modify the form while viewing live data.

* Design View: Provides complete control over form design and properties.

Final Answer: To create a form in MS Access: Select table/query — Go to Create tab —
Choose Form Tool, Form Wizard, or Blank Form — Select fields — Choose layout/style —

Add/arrange controls — Save and test.

Quick Tip
The Form Wizard is ideal for beginners as it guides you through the process step by

step. For more customization, use Design View which gives you complete control over

the form’s appearance and functionality.
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